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About the Axiom™ Genotyping Assay
The first Genome-Wide Association study (GWAS) was published in 2005 (1) when individuals carrying 
particular haplotypes of SNP rs380390 were found to have increased risk of developing age-related 
macular degeneration, a study performed with the Affymetrix GeneChip Mapping 100K Array Set (2).

As of September, 2009, there have been over 400 peer-reviewed GWAS publications and over 1774 SNPs 
have been implicated in human disease (3). Initial GWAS studies focused on the “common disease, 
common variant” hypothesis (1) that held that haplotypes with a minor allele frequency (MAF) >5% 
would show measurable contribution to human disease research.

Current research is shifting towards “complex disease, complex/rare variant” studies. As such, these 
research projects require a broader catalog of human variation, such as is being generated by the 1000 
Genomes Project (http://www.1000genomes.org). This project focuses on identifying alleles with a MAF 
<5% across a broader spectrum of human ethnicities. In order to allow our customers to take advantage 
of this novel and rare content for genome association and candidate gene studies in a cost effective and 
timely manner, Affymetrix is introducing a new genotyping product line: the Axiom™ Genotyping 
Solution. 

The Axiom Genotyping Solution introduces a new genotyping technology platform that includes novel 
assay biochemistry, array configuration and processing, and automated target preparation.

Affymetrix conducted an empirical screen of genomic content from dbSNP 
(http://www.ncbi.nlm.nih.gove/projects/SNP/). The screen included markers from HapMap and the 1000 
Genomes Project as well as other sources, using HapMap phase 3 samples and/or the original 270 
HapMap samples. All of this information has gone into creating a proprietary Affymetrix database of 
validated markers that can be interrogated using the Axiom Genotyping Assay.

Currently two arrays are available for use with the Assay:

Axiom Genome-Wide CEU 1Array: optimized to provide high genetic coverage (r2 >= 0.8) in Northern 
European populations (often referred to as Caucasian or CEU), with lower coverage in ASI and YRI 
populations.

Axiom Genome-Wide ASI 1Array: optimized to provide high genetic coverage (r2 > 0.8) in East Asian 
populations (specifically the HapMap populations of Han Chinese and Tokyo Japanese), with lower 
coverage in CEU and YRI populations.

These arrays are the first in a suite of population specific peg arrays that leverages the content of this 
proprietary Affymetrix database.

The Axiom Genotyping Assay interrogates biallelic SNPs and simple indels in a single, fully automated 
assay workflow. Starting with genomic DNA, the samples are processed by performing either an 
automatic or manual target prep protocol followed by automated processing of the array plates in the 
GeneTitan MC Instrument.

Target prep uses methods including DNA amplification, fragmentation, purification and resuspension 
of the target in hybridization cocktail.

Automated target prep uses the Beckman Coulter Biomek FXP Target Prep Express liquid handler.

Manual target prep enables lab workers to perform the steps without the use of automation 
equipment.

The hyb-ready targets are then transferred to the Affymetrix GeneTitan® Multi-Channel (MC) 
Instrument for automated, hands-free processing (including hybridization, staining, washing and 
imaging).

Cel files generated by the GeneTitan MC Instrument are processed using the Axiom™ Genotyping 
Algorithm version 1 (Axiom GT1) available through Affymetrix Power Tools or Genotyping Console™ 
v4.0. 
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In summary, the Axiom Genotyping Solution is a product line that provides catalog arrays that:

Are optimized for high genetic coverage of their population in question.

Utilize the latest content from dbSNP.

Provide highly automated, reproducible results suitable for GWAS.

Related Documentation
Affymetrix GeneTitan® Multi-Channel Instrument User’s Guide, P/N 08-0308

Affymetrix GeneTitan® Multi-Channel Instrument Site Preparation Guide, P/N 08-0305

Affymetrix GeneChip® Command Console™ 3.1 User Manual, P/N 702569

Genotyping Console User Guide

Axiom gDNA Sample Prep QRC P/N 792928

Axiom Automated Target Prep QRC Setup P/N 702831

GeneTitan MC Protocol for Axiom Array Plate Processing QRC P/N 702929

References

1. Manolio T.A. and Collins F.S.: The HapMap and Genome-Wide Association Studies in Diagnosis 
and Therapy. Annu Rev Medicine 2009, 60:443–56

2. Klein RJ, Zeiss C, Chew EY, et al.: Complement factor H polymorphism in age-related macular 
degeneration. Science 2005, 308:385–89

3. Hindorff LA, Junkins HA, Mehta JP, and Manolio TA.: A Catalog of Published Genome-Wide 
Association Studies. Available at: www.genome.gov/gwastudies. Accessed 09/28/2009.

Overview of the Axiom Assay
Running the Axiom Assay requires the following sets of steps:

1. Genomic DNA Prep--Resulting in samples that meet requirements spelled out in Chapter 2, Genomic 
DNA Preparation and Requirements on page 9.

2. Target Prep of the samples:

The target prep can be done using either:

Biomek Automation (see Chapter 3, Axiom™ Genotyping Assay: Target Preparation with Biomek 
FXP Target Prep Instrument on page 15)

Manual Target Prep (see Chapter 4, Axiom Genotyping Assay: Manual Target Preparation on 
page 95)

3. Array Processing, done with

GeneTitan MC Instrument

GeneTitan Instrument Control software

AGCC Portal software

See Chapter 5, Axiom™ Genotyping Assay: Array Processing with the GeneTitan® MC Instrument 
on page 149.

A list of the required equipment and supplies for running the Axiom Assay using automated target 
preparation and Manual target preparation can be found in the Axiom Site Prep Guide, P/N 702858.

Running Multiple Plate Workflows
Affymetrix provides workflows that allow you to run a set of samples and array plates through the 
protocol using a minimum of personnel and a forty-hour week. The timing of steps is critical, whether 
using automated target prep or manual target prep because of the following constraints:

Incubation after DNA Amplification is 23 hours
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Hybridization in GeneTitan is 23.5 hours.

Reagent trays for wash/stain/imaging must be prepared as Hybridization finishes

Limits to when a second hyb tray and array plate can be loaded into GeneTitan.

These limitations require careful timing.

The details are covered in:

Chapter 6, Automated Target Preparation for Processing Eight Axiom Array Plates Per Week on 
page 183

Chapter 7, Automated Target Preparation for Processing Two Axiom Array Plates per Week on 
page 203

Chapter 8, Manual Target Preparation for Processing Three Axiom Array Plates per Week on page 209

Safety Warnings and Precautions

Copies of the Material Safety Data Sheets for the kit components are available on the Affymetrix website 
at www.affymetrix.com.

CAUTION: All chemicals should be considered as potentially hazardous. We, therefore,
recommend that this product is handled only by those persons who have been trained in
laboratory techniques and that it is used in accordance with the principles of good laboratory
practice. Wear suitable protective clothing, such as lab coat, safety glasses and gloves. Care
should be taken to avoid contact with skin and eyes.

WARNING: The following components contain harmful or toxic ingredients:
Axiom Stabilize Soln: 8% Gluteraldehyde

Axiom HybSoln 2: 100% Formamide

Axiom Hyb Buffer: <55% Tetramethylammonium Chloride

As such we recommend the use of a fume hood when using these products during the Manual
Target Preparation protocol. In all cases customers should use adequate local and general
ventilation in order to minimize airborne concentrations.
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Genomic DNA Preparation and Requirements
The general requirements for genomic DNA (gDNA) sources and extraction methods are described in this 
chapter. The success of this assay requires uniform amplification of the genome starting with relatively 
intact gDNA. To achieve this, the gDNA must be of high quality, and must be free of contaminants that 
may affect the enzymatic reactions to be performed.

For this protocol, you will use the Axiom Reagent Kit (96 reaction, P/N 901281). These kits contain a 
tube labeled Axiom Reference Genomic DNA 103. This DNA meets the requirements outlined below, 
and is included for use as a control. The size and purity of sample gDNA can be compared with those of 
the control DNA to assess sample quality. The control DNA should also be used routinely as an 
experimental positive control and for troubleshooting purposes.

Assay performance may vary for gDNA samples that do not meet the general requirements described 
below. However, the reliability of any given result should be assessed in the context of overall 
experimental design and goals.

The genomic DNA requirements and preparation are described in the following sections:

Sources of Human Genomic DNA

General Requirements on page 9

Genomic DNA Extraction/Purification Methods on page 11

Genomic DNA Cleanup on page 11

Genomic DNA Preparation on page 11

Sources of Human Genomic DNA
The following sources of human gDNA have been successfully tested in the laboratories at Affymetrix 
for DNA that meets the above requirements.

Blood

Saliva

Cell line

Success with other types of samples will depend on quality (degree of degradation, level of purity, etc.) 
and quantity of gDNA extracted.

General Requirements
Starting DNA must be double-stranded for the purpose of accurate concentration determination.

DNA must be of high purity.

DNA should be free of DNA polymerase inhibitors. Examples of inhibitors include high concentrations 
of heme (from blood) and high concentrations of chelating agents (i.e., EDTA). The gDNA extraction/
 purification method should render DNA that is generally salt-free because high concentrations of 
particular salts can also inhibit enzyme reactions. DNA purity is indicated by OD260/OD280 and OD260/
OD230 ratios. The OD260/OD280 ratio should be between 1.8 and 2.0 and the OD260/OD230 ratio should be 
greater than 1.5. We recommend that DNA samples that do not meet these criteria be cleaned up as 
described under Genomic DNA Cleanup on page 11.

DNA must not be degraded.

NOTE: DNA derived from Formalin-Fixed Paraffin-Embedded (FFPE) blocks should not be used
with this assay.
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The approximate average size of gDNA may be assessed on a 1% agarose gel using an appropriate size 
standard control. Approximately 90% of the DNA must be greater than 10 Kb in size. Control DNA 
can be run on the same gel for side-by-side comparison.

Assessing the Quality of Genomic DNA Using 1% Agarose E-gels
We recommend this quality control step to asses the quality of the gDNA prior to starting the assay.

Equipment and Reagents Recommended

Guidelines for Preparing the Genomic DNA Plate
Loading a DNA mass of 10 ng to 20 ng per well is recommended.  If lower amounts are loaded, 
omission of the loading dye is recommended in order to improve visualization. Loading ≥ 25 ng gDNA 
per well can improve the image.

Add 3 µL of 0.1X of RediLoad dye to each sample.

Bring each sample to a total volume of 20 µL using H2O (for example, if the volume of genomic DNA 
is 5 µL, add 3 µL of RediLoad, and bring to 20 µL total by adding 12 µL of H2O). 

Seal, vortex and spin.

To Run the E-Gel:

1. Power on for E-Base (red light).

2. Push the Power/Prg button to make sure the program is at EG mode (not EP).

3. Insert the 2*48 well 1% Agarose E-Gel into slot.

4. Remove 2 combs.

5. Load 20 µL from the above plate onto 2*48 well 1% agarose E-Gel.

6. Load 15 µL of diluted High Range DNA Marker (1:3 dilution or ~ 0.34 X from stock) into all marker 
wells (as needed).

7. Fill all empty wells with water.

8. Adjust the run time to ~27 min.

9. Push the Power/Prg button again (it will change from red to green).

When run time is reached (the ladder band reaches the end of the lane), the system will automatically shut 
off. The gel is then ready for imaging.

Table 2.1  E-Gel® and reagents required

Item Supplier Part Number

Mother E-Base Device

Life Technologies
(formerly Invitrogen)

EB-M03

Daughter E-Base Device EB-D03

E-Gel® 48 1% agarose gels G8008-01

RediLoad™ 750026

E-Gel® 96 High Range DNA Marker 12352-019
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Genomic DNA Extraction/Purification Methods
Genomic DNA extraction and purification methods that meet the general requirements outlined above 
should yield successful results. Methods that include boiling or strong denaturants are not acceptable 
because the DNA would be rendered single-stranded and can no longer be accurately quantitated using a 
PicoGreen-based assay.

Genomic DNA Cleanup
If a gDNA preparation is suspected to contain inhibitors, the following cleanup procedure can be used:

1. Add 0.5 volumes of 7.5 M NH4OAc, 2.5 volumes of absolute ethanol (stored at –20 °C), to gDNA.

2. Vortex and incubate at –20 °C for 1 hr.

3. Centrifuge at 12,000 x g in a microcentrifuge at room temperature for 20 min.

4. Remove supernatant and wash pellet with 80% ethanol.

5. Centrifuge at 12,000 x g at room temperature for 5 min.

6. Remove the 80% ethanol and repeat the 80% ethanol wash one more time.

7. Resuspend the pellet in reduced EDTA TE Buffer (10 mM Tris-HCl pH 8.0, 0.1 mM EDTA).

(See the Axiom Site Preparation Guide P/N 702858 for reagents, equipment, labware and 
consumables for Axiom Assay).

Genomic DNA Preparation
This step needs to be done before proceeding with the DNA amplification stages for either automated or 
manual target prep. 

The human genomic DNA (gDNA) you will process using the Axiom Assay should meet the general 
requirements listed earlier in this chapter. A total of 200 ng gDNA is required.

To prepare gDNA:

1. Thaw Samples and Control

2. Quantitate and Dilute gDNA.

3. Aliquot the Diluted Samples and the Control

4. Freeze or Proceed

5. Create a Batch Registration File

Duration
Thirty minutes to an hour for reagents to thaw and half an hour for setup.

Figure 2.1  Gel images showing intact gDNA and degraded gDNA.
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Equipment, Consumables and Reagents Required

Equipment and Consumables

The equipment and consumables listed in Table 2.2 are required for this stage.

Reagents

The reagents listed in Table 2.3 are required for this stage.

1. Thaw Samples and Control
Thaw the components listed below to room temperature:

gDNA samples

Axiom Reference Genomic DNA 103 (from the Axiom Reagent Kit)

To thaw, either:

Place items on benchtop for one hour

Thaw in a water bath:

A. Fill a small plastic dish with Millipore water. Do not overfill as the level of the water should not 
overflow when the sample tubes or plates are placed in the bath.

B. Thaw the sealed sample plate and Reference sample for a half-hour.

Table 2.2  Equipment and consumables required for Genomic DNA Preparation.

Quantity Item

As required Adhesive seals for plates

1 Ice bucket, filled with ice

1 each Pipettes:

Single-channel P10 or P20
Optional: multi-channel P10 or P20

As required Pipette tips

1 Plate, deep well:

For Automated Target Prep: Beckman Deep Well Titer, polypropylene; P/N 267007
For Manual Target Prep: ABGene 96 Square Well Storage; AB-0932

1 Plate centrifuge

1 Plate spectrophotometer

(required only if no OD measurements available for samples)

1 Vortexer

Table 2.3  Reagents required for Genomic DNA Preparation.

Reagent Supplier Part Number

From the Axiom Reagent Kit

Axiom Reference Genomic DNA 103 (use as a positive control)

located in Module 1, –20 °C

— —

User-supplied

Reduced EDTA TE Buffer (10 mM Tris-HCl pH 8.0, 0.1 mM EDTA) USB
TEKnova

75793
T0223
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C. Wipe off the sample plate after removing and before removing the lid to minimize the chances that 
the water will enter the well and cause contamination or reaction failure.

2. Quantitate and Dilute gDNA

To quantitate and dilute the gDNA:

1. Gently vortex (50% maximum) and spin the gDNA and Reference Genomic DNA 103.

2. Recommendation: quantitate each sample (e.g., using the Quant-iT™ PicoGreen® dsDNA Kit).

3. Dilute each sample to a concentration of 10 ng gDNA/µL using reduced EDTA TE buffer.

4. Seal, vortex and spin.

3. Aliquot the Diluted Samples and the Control
Next, the samples and control are place in one of the following deep well plates for target preparation:

For Automated Target Prep: Beckman Deep Well Titer, polypropylene; P/N 267007

For Manual Target Prep: ABgene 96 Square Well Storage; AB-0932

Aliquot diluted samples and Reference Genomic DNA 103 to the selected deep well plate as follows:

1. 20 µL of each diluted gDNA sample (this should be the equivalent of 200 ng of gDNA).

2. 20 µL of the Reference Genomic DNA 103 control.

We recommend including at least one positive control on each plate.

3. Seal and spin.

4. Freeze or Proceed
At this point you can:

Store the sample plate at –20 °C, or

Proceed to DNA Amplification for:

Automated Target Prep (see Chapter 3, Axiom™ Genotyping Assay: Target Preparation with Biomek 
FXP Target Prep Instrument on page 15)

Manual Target Prep (see Chapter 4, Axiom Genotyping Assay: Manual Target Preparation on 
page 95)

NOTE: Do NOT dilute the Reference Genomic DNA 103 control from the Axiom Reagent
Kit. It is already at a working concentration.

NOTE: You can leave the gDNA sample plate at room temperature if proceeding immediately
to DNA Amplification.
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5. Create a Batch Registration File

GeneTitan Array Plate Registration files contain information that is critical for:

Data file generation during imaging.

Tracking the experimental results for each sample loaded onto an array plate.

Detailed instructions for creating this file are located in Appendix D, Registering Samples in Affymetrix 
GeneChip® Command Console on page 237. See also Figure 2.2 for a screen shot showing an example 
of a batch registration file.

1. Open AGCC Portal > Samples, and select:

A. GeneTitan Array Plate Registration.

B. The array plate format.

C. Click Download.

2. Enter a unique name for each sample and any additional information.

3. Save the file.

The array plate barcode will not be scanned until you are ready to load the array plate and samples onto 
the GeneTitan MC Instrument for processing.

IMPORTANT: It is very important to create and upload a GeneTitan Array Plate Registration
file with your sample information prior to loading the Array Plate and hyb tray in GeneTitan.
We recommend that you create (but not upload) this file at the same time you prepare your
plate of genomic DNA. When your samples are ready for hybridization, you will scan the array
plate barcode and upload the file to Affymetrix GeneChip Command Console (AGCC).

Figure 2.2  Example of a batch registration file
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Axiom™ Genotyping Assay:
Target Preparation with Biomek FXP Target Prep Instrument
The Axiom™ Genotyping Assay with automated target preparation is designed for processing 96 samples 
at a time on Axiom™ Genome-Wide and Custom myDesign™ Array Plates. The protocol is performed 
on two instruments:

Part 1: Target preparation is performed on the Biomek FXP Target Prep Express

Part 2: Array processing is performed on the GeneTitan® Multi-Channel (MC) Instrument

A list of all equipment and resources for the Axiom Genotyping Assay with Automated Target Prep is in 
the Axiom Site Preparation Guide P/N 702858.

This chapter includes instructions for Part 1: target preparation. These instructions are presented as 
follows:

Before Using the Biomek Workstation on page 15

Seal, Vortex and Spin on page 15

Breaking the Light Curtain on page 16

Plate Centrifuge on page 17

Labeling GeneTitan Hybridization and Reagent Trays on page 35

Pipette Tip Usage on page 17

Set the Biomek Software Default Settings on page 17

Equipment, Consumables, Labware and Reagents Required on page 22

Reagent Block Template on page 40

Related Biomek FXP Target Prep Express Documentation on page 40

Stage 1 — DNA Amplification on page 40

Stage 2 — Fragmentation and Purification on page 53

Stage 3 — Resuspension and Hybridization Preparation on page 62

Stage 4 — Preparation for the GeneTitan MC Instrument on page 72

Before Using the Biomek Workstation

Seal, Vortex and Spin
Unless otherwise stated in the protocol, follow the guidelines below when instructed to seal, vortex and 
spin plates or reagent tubes for the Biomek FXP Target Prep Express portion of this assay.

Seal plates — we recommend using MicroAmp Clear Adhesive Films to seal your plates.

Vortex:

Reagents 3 times, 1 sec each time at the maximum setting.

Plates 1 sec each corner, and 1 sec in the center at the maximum setting.

IMPORTANT: Before proceeding to DNA Amplification, do the gDNA preparation described
in Chapter 2, Genomic DNA Preparation and Requirements on page 9.

IMPORTANT: Always ensure that your plates are tightly sealed. A tight seal will prevent
sample loss and cross-well contamination.
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Spin — when instructed to spin plates or reagent vials, follow these guidelines unless otherwise 
instructed (for example, when centrifuging and drying pellets, 5. Centrifuge and Dry Pellets on 
page 61).

Plates:

• Spin at 1000 rpm for 1 min at 4 °C.

• Do not spin for more than 1 min.

Reagent Vials: 3 sec

Breaking the Light Curtain
For your safety, the Biomek FXP Target Prep Express is designed to immediately halt all movement when 
the light curtain is broken.

Light Curtain Broken While Running the Assay

For your safety, the Biomek FXP Target Prep Express is equipped with a light curtain (Figure 3.1). The 
light curtain senses when an object (such as a hand or an arm) enters the space surrounding the deck. 
When this curtain is broken, all movement on the deck halts until the user either clicks OK to resume the 
activity that was taking place, or aborts the activity. Incubation timers are not interrupted.

Figure 3.1  Prompt displayed when the light curtain is broken during the process referred to as Homing All Axes.

The light curtain covers the front of the
instrument. The sides are protected by
Plexiglas. Both areas are shown as red

in this figure. Any penetration of the
light curtain from outside the deck

halts all movement of the workstation.
To resume activity on the deck, click

OK. To abort the step or other activity,
click Stop on the toolbar.
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Pipette Tip Usage

Plate Centrifuge
One plate centrifuge is required for the Axiom™ Genotyping Assay. Refer to the Axiom Site Preparation 
Guide, P/N 702858, for an appropriate plate centrifuge that can be used with the Axiom Genotyping 
Solution When centrifuging and drying pellets as instructed under 5. Centrifuge and Dry Pellets on 
page 61, the centrifuge must be able to spin down plates at:

rpm: 4000

rcf: 3200

temperature: 4 °C

In addition, the bottom of the rotor buckets should be soft rubber to ensure that the deep well plates do 
not crack. Do not spin plates in metal or hard plastic buckets.

Set the Biomek Software Default Settings
Typically you will select the default settings for the Biomek software once. The settings you select will:

Determine the default step selected when the user prompt is displayed at the start of each run. 

Determine which process controls (if any) that will be run during stages 2 and 3 (Fragmentation and 
Resuspension). The process controls include:

Preparation of sample dilution plates for OD and gel analysis during Resuspension and Hyb Prep. 
The dilution plates are taken off-deck. One is used for OD quantitation to evaluate DNA mass; the 
other is used to check fragment size.

Prompt you to manually take samples for DNA quantitation prior to fragmentation.

To select Biomek Software default settings:

1. Launch the Biomek Software.

Table 3.1  Pipette tip usage for one full run of the Axiom™ Genotyping Assay on the Biomek Workstation

Step
Multi-Channel 

P50, Pink
96 tips, P/N 

A21586

Multi-Channel 
AP96 P250, Aqua

96 tips, P/N 
717253

Span-8 
Span P250, 

Green
96 tips, P/N 

379503

Span-8 
Span P1000, 

Yellow
96 tips, P/N 

987925

96 rxns 96 rxns 96 rxns 96 rxns

DNA Amplification — 96 tips — 34 tips

Fragmentation — 96 tips 24 tips 20 tips

Resuspension and Hybridization Preparation 96 tips 96 tips 17 tips 15 tips

Preparation for GeneTitan™

Denature samples
Transfer denatured samples to Hyb Tray
Prepare GeneTitan reagent plates

— 96 tips 26 tips 96 tips

TOTAL 96 tips 384 tips 67 tips 165 tips

NOTE: Refer to the Axiom Site Preparation Guide, P/N 702858, for an appropriate plate
centrifuge that can be used with the Axiom Genotyping Solution.
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2. Open Project > Open Project > Axiom Target Prep and click OK (Figure 3.2).

3. Open File > Open to display the Open Method window (Figure 3.3).

Or click the Open Method icon 

4. Select Axiom Target Prep and click OK.
.

Figure 3.2  Opening the Axiom Target Prep project

Figure 3.3  Opening the Axiom Target Preparation method

The Axiom Target Prep project folder
must be displayed in this menu.
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5. In the left pane of the window, select Axiom Target Prep (Figure 3.4).

The default settings window is displayed on the right.

6. Select your default settings.

Choose defaults settings — these settings can be changed at the start of each step

Which array plate format?

Select 96.

Which step do you want to run?

The step that you choose will be the default setting for the runtime prompt. The actual step selected 
when the runtime prompt is shown reflects the state of the last completed run of the Axiom Target 
Preparation method. For example, if DNA Amplification was the step completed in the last run, 
then the step chosen in the subsequent run would be Fragmentation (the next step in the process). 
If there is no record of the previous run, then the default choice specified is selected.

Select preferences — These settings are displayed in this window only. You must select/deselect here.

QC check points

Figure 3.4  Click Startup Dialog to open the default settings window

NOTE: At present, the Axiom Genome-Wide Assay supports only the 96-array plate format.

The selections made in
this box, Choose default
settings:, are displayed
each time this window

appears.

The options in the
Select preferences box
must be selected prior

to starting a run.
You are not prompted

to select any
preferences at start up.
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Prompt for manual DNA quantitation before fragmentation — the workstation will pause 
following inactivation of the DNA amplification reaction to allow you to manually remove an 
aliquot of each sample for off-line (manual) DNA quantitation. This extra quality control step 
is available for troubleshooting the DNA amplification reaction.

Prepare plates for gel QC and OD after resuspension — the workstation will prepare two plates 
of resuspended samples properly diluted for the fragmentation gel QC and OD quantitation 
process control checks. See Appendix A, Fragmentation Quality Control Gel Protocol on 
page 223 and Appendix B, Sample Quantitation after Resuspension on page 225 for 
instructions and result assessment guidelines.

Custom run options

Run method in test mode — select this option to skip all of the incubation timers in a step. If 
selected, a prompt is displayed asking you to confirm that you want to run a step in test mode 
(Figure 3.5). Use this option to perform runs using water only, not actual reagents or samples.

Deck configuration options

TRobot- select this option to perform the denaturation of the Axiom Hyb Ready Plate on the 
integrated Biometra TRobot 96 thermal cycler

PTC - select this option to perform the denaturation of the Axiom Hyb Ready Plate on the 
integrated Bio-Rad PTC-200 thermal cycler

No integrated thermal cycler - select this option to perform the denaturation of the Axiom Hyb 
Ready Plate on an off-deck thermal cycler or if your Biomek does not have an integrated thermal 
cycler. A list of thermal cyclers that have been verified with the assay can be found below. When 
selecting this option, select the appropriate plate type that should be used for the Hyb Ready 
Plate. 

Select the Bio-Rad Skirted option when using the HSP 9631 plate for the PTC-200 or the Bio-
Rad Tetrad 0240G thermal cycler.

Select the Bio-Rad Semi-Skirted on Costar Round Bottom option for the ABI 9700 or the ABI 
2720 thermal cycler. The Bio-Rad HSS 9601 plate must be stacked onto the Costar Round 
Bottom plate from Corning (VWR International P/N 29442-392, E&K Scientific: EK 
680568, Corning Mfg PN 3795) for the robot to prepare the Hyb Ready Plate.

We have verified the performance of this assay using the Bio-Rad PTC-200/PTC-200G and Biometra 
TRobot 96 on the Beckman Biomek Target Prep Express liquid handler. We have also verified the 
performance of this assay using the following off-deck thermal cyclers:

Bio-Rad PTC-200G 

Biometra TRobot 96

IMPORTANT: For troubleshooting and support purposes, we strongly recommend that
you perform the gel QC and OD quantitation process controls after resuspension.

CAUTION: Never process samples in test mode. The assay will fail; all of your
samples and reagents will be lost.

Figure 3.5  Prompt displayed when the custom run option, Run method in test mode, is selected.
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ABI 9700 with a gold, silver or aluminum block

ABI 2720 

Bio-Rad MJ 0240G 

The performance of this assay has not been verified with other thermal cyclers. 

Use of other thermal cyclers may result in assay failure and may violate the Axiom Array and Reagent 
replacement policy.

The thermocycler needs to be programmed with the “Axiom Denature” protocol:

A. 95 °C 20 min

B. 48 °C 3 min

C. 48 °C hold

Use the heated lid option when setting up or running the protocol.

7. Click Start at the top of the left pane to close the default settings window.

IMPORTANT: The default settings you select here will be displayed each time the Axiom
Target Prep window is displayed. 

The options displayed in the Startup Dialog box as shown in Figure 3.4 on page 19 must
be selected prior to starting a run. These settings are not prompted for at runtime.

WARNING: Evaporation during denaturation can negatively impact assay performance. Use
the recommended thermal cycler consumables and sealing film to eliminate condensation
and evaporation. The arched, auto-sealing metal plate with P pads as shown in Table 3.2 on
page 22 should be replaced after use as per the manufacturers recommendation.
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Equipment, Consumables, Labware and Reagents Required

Labware used on the Biomek Workstation deck

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image

Biomek AP96 – P250 Pipette Tips 

(aqua box; pre-sterile, barrier)

Beckman Coulter

P/N 717253

Biomek Span P1000 Pipette Tips 

(yellow box; pre-sterile, barrier, 
conductive)

Beckman Coulter

P/N 987925

Biomek Span P250 Pipette Tips 

(green box; pre-sterile, barrier)

Beckman Coulter

P/N 379503
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Biomek Span P50 Pipette Tips 

(pink box; pre-sterile, barrier)

Beckman Coulter

P/N A21586

BIO-RAD Hard Shell 96-well plate

(available in multiple colors)

BIO-RAD

P/N HSP9631

Lid, metal

(arched, auto-sealing with P pads)

BIO-RAD

P/N MSL-2032 and 

P Pad P/N: MSP-1003 

Beckman Deep Well Titer Plate

(polypropylene)

Beckman Coulter

P/N 267007

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image

Front view

Side view
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ABGene 96 Square Well Storage 
Plate

(2.2 mL)

Thermo Scientific

P/N AB-0932

OD Plate, UV E & K Scientific

EK-25801

Frame for Reservoirs Beckman Coulter

P/N 372795

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image

Frame
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Plate, Costar Brand Serocluster round 
bottom plate from Corning

Note: this consumable is required if 
using an off-deck ABI 9700 or ABI 
2720 thermal cycle

VWR International P/N 
29442-392

E&K Scientific EK 
680568

Corning Mfg PN 3795

Hard-Shell Full-Height 96-Well Semi-
Skirted PCR Plate required only if using 
off-deck ABI 2720 or ABI 9700 Thermal 
cyclers

Bio-Rad HSS-9601

The ABI 9700 and the ABI 2720 use the semi-skirted 96-well plates 
(PN HSS-9601) stacked on a Costar brand Serocluster 96-well 
Round Bottom Microtitration plate as shown in the figure below

A 96-well semi skirted PCR plate stacked on a Costar Branded 
Round Bottom 96 well plate. 

Half Reservoir

Half module, 75 mL capacity

Beckman Coulter

P/N 372786

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image
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Quarter Reservoirs
Quarter module, 40 mL capacity
Quarter module divided by width, 
19 mL capacity each receptacle

Beckman Coulter

P/N 372790 (40 mL)

P/N 372792 (19 mL)

Reagent block, chilled to 4 °C Beckman Coulter

P/N A83054

Reagent block template

(designed specifically for use with the 
Axiom Reagent Kit)

Contact Affymetrix

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image

Divided by width
19 mL capacity

Undivided
40 mL capacity

A1 Metal posts on block circled in red.

Template on reagent block. Metal posts on block 
circled in red.
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24-Position Tube Rack

with one 11 mm tube insert in position 
A6.

Beckman Coulter

P/N 373661 (rack)

P/N 373696 (insert)

Adaptor, Deep Well Plate 

(installed on the Shaking Peltier)

This adaptor is typically installed by a 
Beckman Coulter field service technician 
during new system installation or a 
system upgrade. Ensure that you have 
one of these adaptors on the deck prior 
to running this assay.

Beckman Coulter

P/N A83050

Table 3.2  Labware used on the Biomek Workstation deck

Labware Supplier and Part 
Number

Labware Image

Tube insert 
A6

The metal block is the adaptor.
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GeneTitan MC Consumables

All consumables for the GeneTitan MC Instrument are provided by Affymetrix. The following table 
provides guidance on the consumables that are shipped with the Array Plate.

IMPORTANT: All covers must have barcodes. Discard any cover without a barcode.

Table 3.3  Axiom GeneTitan Tray consumables  

Item Part Number Labware Image Information

HT Array 
Plate 
Package

All array plates 
have the PN 
202091 etched 
on the on the 
plastic

The HT Array Plate 
shipping package 
includes the following:

The function of the clear 
plastic cover for the 
Array Plate is to protect 
the Array Plate during 
transport. You can 
discard this after 
removing the Array 
Plate.
The Array Plate must be 
protected at all times 
from damage or 
exposure to dust. The 
Array Plate must be in 
the Blue Array Plate 
Protective Base at all 
times.
The Blue Array Plate 
Protective Base in the 
package must be used 
to protect the Array 
Plate from damage.
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The HT Scan Tray 
shipping package

includes the following:

The HT Scan tray 
includes a Scan Tray 
cover. The tray cover 
should be used to cover 
the scan tray before 
placing the tray in the 
GeneTitan MC 
Instrument. The Tray 
cover should be de-
ionized before use. See 
the section Appendix E, 
Deionization Procedure 
for GeneTitan Trays and 
Covers on page 241 for 
the anti-static 
procedure.
The Scan tray must be 
protected at all times 
from damage or 
exposure to dust. The 
Scan Tray must be in the 
Black Plate Cover at all 
times.
The Black Scan tray 
cover in the package is 
used to protect the scan 
tray glass from damage. 
The black scan tray is 
distinct from the Blue 
Array Plate Protective 
Base and must not be 
used with the Array 
Plate. Remove the 
protective base from the 
scan tray before loading 
the scan tray with the 
scan tray cover

Black Scan 
Tray 
protective 
base

PN 202096 The Black Scan tray 
cover in the package is 
used to protect the scan 
tray glass from damage. 
The black scan tray is 
distinct from the Blue 
Array Plate Protective 
Base and must not be 
used with the Array 
Plate.
Remove and discard the 
protective base from the 
scan tray before loading

Table 3.3  Axiom GeneTitan Tray consumables (Continued) 

Item Part Number Labware Image Information
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Scan Tray 
with cover

Scan Tray 501006

Cover 202757

The GeneTitan Scan tray 
must be loaded with the 
scan tray cover into the 
GeneTitan instrument
Do not load the scan 
tray with the protective 
base

GeneTitan 
Stain Trays

501025 The GeneTitan stain trays 
are packaged in ziplock 
bags to keep them free 
of dust. The GeneTitan 
stain trays are barcoded 
and tray have separator 
walls that are flush with 
the frame of the stain 
tray as shown by the 
yellow line.

Table 3.3  Axiom GeneTitan Tray consumables (Continued) 

Item Part Number Labware Image Information
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GeneTitan 
Scan and

Stain Tray 
cover

202757 The GeneTitan scan and 
stain tray covers are 
provided to prevent any 
evaporation of the 
stains in stain trays and 
the array holding buffer 
in the scan tray
All stain and scan trays 
must be placed in the 
GeneTitan instrument 
with the GeneTitan stain 
tray cover.
All tray covers must be 
de-ionized to remove 
static electricity prior to 
placing the cover on the 
tray. 
See the section 
Deionization Procedure 
for GeneTitan Trays and 
Covers on page 241 for 
the anti-static 
procedure.

GeneTitan 
stain tray 
shown with 
the stain 
tray cover

Tray 501025

Cover 202757

The GeneTitan stain 
trays must be placed in 
the GeneTitan 
instrument with the 
GeneTitan stain tray 
cover.
It is important to remove 
the static electricity on 
the cover and the stain 
tray prior to loading the 
tray into the GeneTitan 
instrument.
See the section 
Deionization Procedure 
for GeneTitan Trays and 
Covers on page 241 for 
the anti-static 
procedure.

GeneTitan 
Hyb Tray

500867 The GeneTitan 
hybridization trays are 
packaged in white 
pouches with the label 
“HT Hybridization 
Tray.”
After aliquoting the hyb 
cocktail into the 
hybridization tray, the 
tray should be loaded 
into the GeneTitan 
instrument with the 
barcode facing away 
from the operator, i.e., 
Barcode should be on 
the back side.

Table 3.3  Axiom GeneTitan Tray consumables (Continued) 

Item Part Number Labware Image Information
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Proper Tray Alignment and Loading
Proper alignment and loading of plates, covers and trays is critical when using the GeneTitan MC. Each 
plate, cover and tray has one notched corner. The notched corner of plates, trays, covers and bases must 
be in vertical alignment with each other, and placed in position A1 per the Tray Alignment guide inside 
each GeneTitan MC drawer (Figure 3.6 and Figure 3.7 on page 34).

IMPORTANT: When running a multi-plate workflow, you must pay careful attention to the
software prompts that tell you which side of the drawer to place or remove a plate/tray.

TIP: Mark the notched corner of each plate, cover and tray with permanent marker to help
ensure proper alignment and loading onto the GeneTitan MC.

CAUTION: Take care not to damage the consumables or bend the blue base posts or scan tray
posts.
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Figure 3.6  Proper alignment and loading of plates, covers and trays in the GeneTitan MC.

Plates and trays must be seated in this 
rectangular recess.

The notched corner of all plates, bases, and 
covers and must be seated in this corner of 
the drawer per the Tray Alignment guide.

Tip
Mark the notched corner of each plate, 
cover and tray with permanent marker to 
help ensure proper alignment and loading.

Notched corner of Array Plate aligned 
with notched corner of blue base.

IMPORTANT: Remove the
plastic protective shipping
tray cover.
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Stain Trays and Covers

Figure 3.7  Array Plate with protective blue base and the Hyb Tray aligned and properly loaded into drawer 6.

IMPORTANT: When you install the consumables, ensure that the fingers are retracted (do
not put the consumables onto the drawer tab, or fingers - this indicates that the
instrument is not functioning correctly. See the Important note on on page 37 for an
image of the tabs.

IMPORTANT: Always place the flat side of the cover against the Stain Tray.

Figure 3.8  Placement of covers on trays

Array Plate with protective blue base Hyb Tray 

Correct placement of cover on Stain Tray. Incorrect placement of cover on Stain Tray.
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Labeling GeneTitan Hybridization and Reagent Trays

When preparing the hybridization and reagent trays to be loaded onto the GeneTitan MC Instrument, you 
will need to mark each tray in a way that identifies its contents.

Proper labeling for Hyb Trays and reagent trays is described in:

Labeling for Hyb Trays, below

Labeling for Stain Trays on page 36

Labeling for Hyb Trays

You may label the Hyb Tray on the front part of the short side of the tray, next to the notch at the left, 
as shown in Figure 3.9. The proper section for labeling is closest to the notched corner, corresponding to 
the A1 and B1 wells.

IMPORTANT: It is critical that you write only on the proper locations of the proper sides of
Hyb and Stain Trays. Do NOT write in any other location, as this can interfere with sensors
inside the GeneTitan MC Instrument and result in experiment failure. To ensure proper
placement of lids onto stain trays, and trays onto the GeneTitan MC Instrument, you can also
mark the notched corner of the trays and lids.

Figure 3.9  Labeling GeneTitan hyb trays

CAUTION: Writing on the wrong side of the Hyb tray may interfere with the operation of
sensors in the GeneTitan MC Instrument.
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Labeling for Stain Trays

You may label the stain trays on the left side of the front of the tray as shown in Figure 3.10. The correct 
side is closest to the notched corner, corresponding to the A1 through C1 wells.

Loading Tray Consumables onto the GeneTitan MC
Loading, or installing, the trays and plates onto the GeneTitan MC Instrument is a simple procedure, but 
there are certain precautions that you must take in order to ensure an error-free procedure. The following 
figures show you how to do it.

IMPORTANT: Do not confuse hyb trays with stain trays. 

Figure 3.10  Labeling GeneTitan stain tray
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Figure 3.11  Scan tray loaded in drawer 2.

IMPORTANT: When you load the plates, or trays, insert them under the tabs, or fingers, that
may protrude into the stage. Confirm that the tray is not resting on these fingers.

Scan Tray with cover 
loaded in drawer 2. 

Do NOT load the protective black 
base packaged with the Scan Tray.
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Figure 3.12  Stain 1 Tray and Ligation Tray loaded in drawer 3.

Figure 3.13  Stain 2 Tray and Fix Tray loaded in drawer 4.

Stain 1 Tray and Ligation Tray 
loaded in drawer 3

Stain 2 Stain Tray and Stabilize 
Tray loaded in drawer 4
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Figure 3.14  Stain 1 Tray loaded in drawer 5.

Stain 1 Tray loaded in drawer 5.
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Reagent Block Template
The Axiom Reagent Kit template fits precisely onto the top of the chilled reagent block, and is held in 
place by the metal posts on the block (Figure 3.15). Using this template will help ensure the proper 
placement of reagent tubes onto the block for each method.

Related Biomek FXP Target Prep Express Documentation
The following user manuals are installed at the same time as the Biomek FXP Target Prep Express 
software (Start > All Programs > Beckman Coulter > Manuals). Refer to these for troubleshooting the 
Biomek workstation.

Biomek® Liquid Handler User’s Manual, Beckman Coulter P/N 987834

Biomek® Software User’s Manual, Beckman Coulter P/N 987835

Stage 1 — DNA Amplification

Duration

Figure 3.15  Axiom reagent template for the 
reagent block

IMPORTANT: Before proceeding to DNA Amplification, do the gDNA preparation described
in Chapter 2, Genomic DNA Preparation and Requirements on page 9.

NOTE: For this protocol, the term samples includes the positive control.

NOTE: A 22-24 hr incubation is required at the end of this stage.

Table 3.4  Time required for Stage 1 — DNA Amplification

Hands-on time ~ 30 min

Biomek FXP Target Prep Express ~ 19 min

Incubation 23 hr

Total time ~ 24 hr
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Equipment, Consumables, Labware and Reagents Required

Equipment and Labware Required

Reagents Required

Table 3.5  Equipment and labware required

Quantity Item

As required Adhesive seals for plates

1 Bench top cooler, chilled to –20 °C

1 Ice bucket, filled with ice

As required Kimwipes®

1 Marker, fine point, permanent

1 Mini microcentrifuge (microfuge with microtube rotor)

1 Oven (must maintain a constant temperature of 30 °C for at least 23.5 hr with a temperature 
accuracy of +/– 1 °C)

> 3 array plates per week — we recommend using the Binder ED 53
≤ 3 Array plates per week — OK to use the GeneChip Hybridization Oven or the Binder ED 53

1 Plate centrifuge

1 Vortex

Biomek Workstation Labware

1 box of each Barrier pipette tips:

Biomek Span P1000 (yellow)
Biomek AP96, P250 (aqua)

2 Plate, BIO-RAD hard shell PCR 96-well

2 Plate, deep well titer

1 Reagent block, chilled to 4 °C

2 Reservoir, quarter module (40 mL)

3 Reservoir, half module (75 mL)

Table 3.6  Reagents required for DNA amplification

Axiom Reagent Kit Module

Axiom Denat Soln 10X

Module 1, –20 °C

Axiom Neutral Soln 10X

Axiom Amp Soln

Axiom Amp Enzyme

Axiom Water
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1. Perform the Pre-Run Checklist

Check the Water and Waste Containers

To check the system water and waste containers:

1. If necessary, fill the system water container using distilled, deionized water (no need for ultra-pure 
water).

2. If necessary, empty the system waste bottle.

Turn on the Biomek FXP Target Prep Express

To turn on the workstation:

1. Power on the workstation.

2. Ensure that all of the peripherals are powered on.

Watlow temperature controllers

Control the Static Peltier (Pelt_1) and the Shaking Peltier (SPelt_96); no additional power supply.

Thermal cycler:

BIO-RAD PTC-200 or Whatman Biometra TRobot 96 if present on the Biomek workstation deck. 
Otherwise, a stand-alone thermal cycler can be used.

3. Launch the Biomek Software by double-clicking the Biomek Software icon on the desktop .

You can also open Start > All Programs > Beckman Coulter > Biomek Software.

Close the thermal cycler (on deck thermal cycler)

If your Biomek Workstation includes a PTC200 or a Biometra TRobot 96, the lid may remain open upon 
startup. You must close the thermal cycler lid prior to homing the axes or starting a method.

The lid of the PTC-200 opens automatically when the device is powered up. While the lid of the TRobot 
does not power up automatically, it is possible that the lid may be open from a previous run or at the 
beginning of the next run.

CAUTION: Close the thermal cycler lid:

If it remains open after you have powered on the workstation.

If the lid is up before you home the axes or before you begin a method.

If not closed, the MC Pod may collide with the thermal cycler lid and damage the instrument.

NOTE: Refer to page 12 of the Setup Guide and User's manual for Biometra TRobot on the
Biomek FXp. After following the instructions to close the thermal cycler lid, proceed to Home
All Axes on page 44.
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Closing the thermal cycler lid on the PTC-200

1. Open Instrument > Device Editor.

2. Open the Device drop-down menu and select PTC200Left.

3. Click Action Commands.

4. Select the following (Figure 3.16 on page 44):

A. In the Actions box, select Close.

B. In the Open/Close box, select Without plate.

5. Click Close Lid.

A Status window is displayed while the lid is being closed (Figure 3.17).

6. Click OK when the Command executed prompt is displayed (Figure 3.17).

7. Click Cancel; then click Close.

IMPORTANT: It is critical that you select Without plate in the Open/Close box. If a plate
is present, remove it now.
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Home All Axes

This procedure will home all axes and prime the fluidics lines.

To home all axes:

1. Open Instrument > Home All Axes.

2. Ensure all conditions in the Warning prompt Figure 3.18 (1.) are met, then click OK.

An icon instructing you to Stop and wait while the instrument homes is displayed (2.).

Figure 3.16  Closing the thermal cycler lid

Figure 3.17  Closing PTC Lid prompts.

Very Important to avoid 
damaging the thermal cycler
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3. When:

A. The Warning prompt in Figure 3.19 (A.) is displayed, confirm that no tips are loaded in the Span-
8 Pod, and click OK.

The lines for the Span-8 tips are primed and the next prompt shown in Figure 3.19 (B.) is 
displayed.

B. When the intake (syringes and tubing) for the Span-8 tips is clear of bubbles, click OK.

2. Thaw and Prepare the Reagents and Sample Plate

Thaw and Prepare the Reagents and Sample Plate

To thaw and prepare the reagents:

1. Thaw the sample plate on the bench top at room temperature and spin.

2. Thaw the following reagents on the bench top at room temperature.

Axiom Denat Soln 10X

Axiom Neutral Soln 10X

Axiom Amp Soln

Axiom Water

Leave the Axiom Amp Enzyme in the freezer until ready to use.

3. Vortex and spin all reagents (except Axiom Amp Enzyme), then place on ice.

Vortex the Axiom Amp Soln for 30 sec to thoroughly mix.

For the Axiom Amp Enzyme, just before placing on the deck gently flick the tube 3 times to mix 
and spin.

4. Preheat the Oven to 30 °C.

We recommend using one of these ovens:

Figure 3.18  Homing all axes

Figure 3.19  Prompts displayed for priming the Span-8 Pod fluidic lines.

NOTE: Do not place a frozen sample plate directly on the workstation deck. 

1. 2.

A. B.
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Binder FD53

Affymetrix GeneChip® Hybridization Oven (turn rotation on to 15 rpm)

4. Run the DNA Amplification Step

To run the DNA Amplification step:

1. Open Project > Open Project > Axiom Target Prep (Figure 3.20) and click OK.

2. Open File > Open to display the Open Method window (Figure 3.21).

Or click the Open Method icon 

3. Select Axiom Target Prep and click OK.

4. At the top of the main window, click the Run button to open the Axiom™ Target Prep window 
(Figure 3.22 – A.).

5. In the Axiom Target Preparation window (Figure 3.22 – B.):

A. Select your Array Plate format.

B. Select DNA Amplification.

Figure 3.20  Opening a project

Figure 3.21  Opening the Axiom Target Preparation method

The Axiom Target Prep
project folder must be

displayed in this menu.
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C. Click OK.

The Deck Layout for DNA Amplification is displayed (Figure 3.23 on page 48).

6. Place the labware and reagents on the deck as directed in the following figures and table:

Figure 3.23 on page 48 — deck layout

Table 3.7 on page 48 — labware and reagents

Figure 3.24 on page 49 — reagent block

Figure 3.22  Opening the Axiom Target Preparation methods window

IMPORTANT: Axiom Amp Enzyme — Immediately prior to placing on the reagent block,
gently flick the tube with your finger two to three times to mix; then spin. Do NOT vortex.

A. Run button

B.
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Figure 3.23  Deck layout window for the DNA Amplification method

Table 3.7  Labware and reagent locations on the deck for the DNA Amplification method

Position on 
Deck

Labware Reagent or Samples

TL1 Biomek AP96 – P250 Pipette Tips (aqua) —

P4 Beckman Deep Well Titer Plate gDNA samples

P5 BIO-RAD Hard Shell 96-well plate (any color) —

P6 BIO-RAD Hard Shell 96-well plate (any color)

SPelt96_1 Beckman Deep Well Titer Plate —

P10 Reservoirs in frame:

Quarter module (1)
Quarter module (2)
Half module (3)

Leave all reservoirs empty

Important: No tips
should be loaded onto

the movable arms
referred to as the Span-8

(right) and the
Multichannel

(MC; left) pods.

MC pod uses the pipette
tips in this position.

Span-8 pod uses the pipette tips in
this position.

1 2 3

EmptyEmptyEmpty
Reservoir Reservoir Reservoir
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P11 Reservoirs in frame:
Half module (1)
Half module (2)

Pour Axiom Water into reservoir 1
Pour Axiom Amp Soln into reservoir 2

Pelt_1 Reagent block, chilled to 4 °C See Figure 3.24.

P13 Biomek Span P1000 Pipette Tips (yellow) —

Figure 3.24  Placement of reagents on chilled reagent block for GeneTitan reagent tray preparation

Table 3.7  Labware and reagent locations on the deck for the DNA Amplification method

Position on 
Deck

Labware Reagent or Samples

1 2

Axiom
Amp Soln

Axiom Water

IMPORTANT: 
Position all plates and the chilled reagent block with A1 in the upper left corner of the frame.
Press reagent tubes into the block to ensure that they are fully seated.

A1

Axiom 
Amp 

Enzyme

Axiom 
Neutral 

Soln 10X

Axiom 
Denat 

Soln 10X
A1

Reagent block with template.
Only the positions used for this

method are shown.

Flick and spin the Amp Enzyme
before placing in block.

Diagram of reagent block
without template
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7. Check the deck layout to ensure that all labware and reagents are in the proper locations.

8. Click OK.

The system flushes the Span-8 fluidics system. Observe the lines and syringes for air bubbles.

9. At the prompt to repeat the Span-8 fluidics system flush:

Click No if no air bubbles are present.

Click Yes if air bubbles are present. Repeat the flush until no air bubbles are present.

The DNA Amplification step runs until the Amplification Master Mix has been added to the sample plate. 
Once complete, the instructions and prompt shown in Figure 3.26 are displayed.

Follow the instructions for the sample plate (see also User Intervention below).

Follow the instructions for clearing the workstation deck.

User Intervention

1. Remove the sample plate.

2. Blot the top of the plate with a Kimwipe to remove any droplets that may be present.

3. Tightly seal the plate.

4. Place in a preheated oven and incubate at 30 °C for 22 to 24 hr.

5. After 22 to 24 hr of incubation, do one of the following:

Proceed directly to Stage 2 — Fragmentation and Purification on page 53

Tightly seal and store the amplified samples at –20 °C.

NOTE: If the physical deck does not match the Deck Layout and Confirmation window
exactly (Figure 3.23 on page 48), either modify the physical deck to match exactly or
choose Abort in the Deck Layout and Confirmation window.

Figure 3.25  Flushing the Span-8 fluidics system to purge air bubbles.

Figure 3.26  Instructions for clearing the workstation deck

NOTE: If using a GeneChip® Hybridization Oven, place the plate on the bottom of the
oven. Plates do not rotate.

Prompt for 
Span-8 flush

IMPORTANT: 
Seal the sample plate before placing in the 
oven.
Always discard the used multi-channel pipette 
tips in position P3.
Always store the reagent block at 4 °C.
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Summary of DNA Amplification

Span-8 Pod ActivitiesMC Pod Activities

3 min incubation on deck at 
room temperature

Continued on next page.
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Span-8 Pod ActivitiesMC Pod Activities
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Stage 2 — Fragmentation and Purification

Duration

Equipment, Consumables, Labware and Reagents Required

Equipment and Labware Required

NOTE: Purification is done by precipitation (4. Precipitation on page 61).

Table 3.8  Time required for Stage 2 — Fragmentation and Purification

Hands-on time ~ 25 min

~ 50 min if frozen DNA from Step 1

Biomek FXP Target Prep Express
Deactivation incubation — 40 min to deactivate the 
amplification reaction
Fragmentation incubation — 30 min 

~ 1:35 hr — 96 samples

Total time  2:00 to 2:25 hr

Table 3.9  Equipment, consumables and labware required

Quantity Item

As required Adhesive seals for plates

1 Bench top cooler, chilled to –20 °C

1 Freezer, –20 °C

1 Ice bucket, filled with ice

As required Kimwipes

1 Marker, fine point, permanent

1 Mini microcentrifuge (microfuge with microtube rotor)

1 Oven, preheated to 48 °C, with a temperature accuracy of +/– 1 °C

1 Plate centrifuge, 4 °C

1 Vortex (for plates and microtubes)

Beckman Labware

1 box of each Barrier pipette tips:

Biomek AP96, P250 (aqua)
Biomek Span P250 (green)
Biomek Span P1000 (yellow)

3 Plate, BIO-RAD hard shell PCR 96-well

1 Plate, ABgene 96 Square Well Storage 

1 Reagent block, chilled to 4 °C

3 Reservoir, quarter module

1 Reservoir, half module
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Reagents Required

1. Perform the Pre-Run Checklist
The following actions are the same as described under 1. Perform the Pre-Run Checklist on page 42. 
Refer back to this step for details. Some or all of these steps may not be required depending upon the 
current state of the Biomek workstation.

To perform the pre-run checklist:

1. Power on the Biomek FXP Target Prep Express and all peripherals.

2. Check the water and waste containers; replenish or empty as required.

3. Launch the Biomek Software.

4. If applicable, close the thermal cycler lid (on page 42).

5. Home all axes (on page 44).

2. Thaw and Prepare the Samples and Reagents

Thaw and Prepare the Sample Plate

If the plate of amplified samples is frozen:

1. Place the deep well plate in a small water bath.

For example, pour Millipore water into a small tray. Place the frozen plate on the water in the tray.

2. Leave the plate in the water bath for ~ 50 min until all wells have thawed.

3. Spin down at 1000 rpm for 30 sec.

4. To avoid cross-contamination of wells during vortexing:

A. Remove the seal and blot the top of the plate with a Kimwipe.

B. Tightly reseal the plate with a fresh seal.

5. Vortex the plate for 30 sec to thoroughly mix.

6. Spin at 1000 rpm for 30 sec.

Table 3.10  Reagents required for the Fragmentation method

Reagent Module

From the Axiom Reagent Kit

Axiom Frag Enzyme (leave at –20 °C until ready to use)
Module 2

Box 1, –20 °CAxiom 10X Frag Buffer

Axiom Precip Soln 2

Axiom Frag Diluent
Module 2

Box 2, 2–8 °CAxiom Frag Rxn Stop

Axiom Precip Soln 1

User-supplied

Isopropanol, 99.5% 96 samples: 65 mL
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Thaw and Prepare the Reagents

To thaw and prepare the reagents:

1. Thaw the following reagents on the bench top at room temperature.

Axiom 10X Frag Buffer

Axiom Precip Soln 2

2. Vortex and spin all reagents (except Axiom Frag Enzyme), then place on ice.

For the Axiom Frag Enzyme: Leave at -20 degrees C until ready to use. Just before placing on the 
deck gently flick the tube 3 times to mix and spin 

3. Run the Fragmentation Step

To open the Target Preparation Methods window:

1. Open Project > Open Project > Axiom Target Prep and click OK.

2. Click the Open Method icon, select Axiom Target Prep, and click OK.

3. Click the Run button.

4. Select the array plate format and Fragmentation, then click OK (Figure 3.27).

The deck layout for Fragmentation is displayed (Figure 3.28).

5. Setup the deck with the labware and reagents as shown in Figure 3.28 on page 56, Table 3.11 on 
page 56, and Figure 3.29 on page 57.

Figure 3.27  

IMPORTANT: Remove the seal from the sample plate before placing on the deck.
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Figure 3.28  Deck layout for the Fragmentation method

Table 3.11  Labware and reagent locations on the deck for the Fragmentation

Position 
on Deck

Labware Reagent or Samples

TL1 Biomek AP96 – P250 Pipette Tips (aqua) —

P4 BIO-RAD Hard Shell 96-well plate —

P5 BIO-RAD Hard Shell 96-well plate —

P6 BIO-RAD Hard Shell 96-well plate —

P7 Beckman Deep Well Titer Plate Amplified gDNA

P8 ABgene 96 Square Well Storage Plate —

P10 Reservoirs in frame:
Quarter module (1)
Quarter module (2)

Pour Axiom Frag Rxn Stop into reservoir 1
Pour Axiom 10X Frag Buffer into reservoir 2

P11 Reservoirs in frame:

Half module (1)
Quarter module (2)

Pour Isopropanol into reservoir 1
Pour Axiom Precip Soln 1 into reservoir 2

1 2

Frag

Stop

Axiom

Buffer

Axiom

Rxn
10X Frag

1 2

PrecipIsopropanol
Sol 1

Axiom
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6. Check the deck layout to ensure that the labware, reagents and samples are in the proper locations.

7. Click OK to continue.

Pelt_1 Reagent block, chilled to 4 °C See Figure 3.29 on page 57.

P13 Biomek Span P1000 Pipette Tips (yellow) —

P14 Biomek Span P250 Pipette Tips (green) —

Figure 3.29  Placement of reagents on chilled reagent block for GeneTitan reagent tray preparation

NOTE: If the physical deck does not match the Deck Layout and Confirmation window
exactly (Figure 3.28 on page 56), either modify the physical deck to match exactly or
choose Abort in the Deck Layout and Confirmation window.

Table 3.11  Labware and reagent locations on the deck for the Fragmentation

Position 
on Deck

Labware Reagent or Samples

IMPORTANT: 
Always position the chilled reagent block with A1 in the upper left corner of the frame.
Press reagent tubes into the block to ensure that they are fully seated.

A1

Axiom 
Precip 
Soln 2

Axiom 
Frag 

Diluent

Axiom 
Frag 

Enzyme
A1

Reagent block with template.
Only the positions used for this

method are shown.

Diagram of reagent block
without template

Axiom Frag Enzyme:
Flick to mix 3X and spin 
immediately prior to placing on 
the chilled reagent block.
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The system will automatically flush the Span-8 fluidics system. Observe the lines and syringes for air 
bubbles.

8. At the prompt to repeat the Span-8 fluidics system flush:

Click No if no air bubbles are present.

Click Yes if air bubbles are present. Repeat the flush until no air bubbles are present.

The Fragmentation step begins. The sample plate is incubated at 65 °C to inactivate amplification. If you 
selected Prompt for manual DNA quantitation in the default software settings, you will then be prompted 
to remove an aliquot of each sample for a quantitation process control. The plate will remain at 40 °C 
until the aliquots have been collected.

NOTE: Remain near the Biomek FXP Target Prep Express if you are going to remove
aliquots for quantitation. Avoid leaving the samples at 40 °C for a long period of time.
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Summary of Fragmentation

Span-8 Pod ActivitiesMC Pod Activities

Continued on next page.

Incubate on deck
30 min at 40 °C

Incubate on deck:
20 min at 65 °C
20 min at 40 °C

Optional pause available for 
manual DNA quantitation. See 
Set the Biomek Software Default 
Settings on page 17.
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4. Precipitation

To freeze the samples:

1. Remove the Precipitation Plate from the deck.

2. Blot the top of the plate with a Kimwipe and seal tightly.

3. Place the plate in a –20 °C freezer overnight to precipitate.

4. Return to the Biomek workstation and clear the deck.

5. Centrifuge and Dry Pellets

To centrifuge and dry the pellets:

1. Turn the oven on and preheat to 48 °C.

Use an oven that can sustain a constant temperature of 48 °C and has a temperature accuracy of 
+/– 1 °C (we recommend the Binder FD53). If processing three or fewer array plates, you can use a 
GeneChip Hybridization Oven.

2. Centrifuge the plate at 3200 xg (or rcf) at 4 °C for 40 min.
.

3. Immediately after the 40 min centrifugation period, empty the liquid from the plate as follows:

A. Remove the seal.

B. Invert the plate over a waste container and allow the liquid to drain.

C. While still inverted, gently press the plate on a pile of Kimwipes on a bench and leave it for 5 min.

4. Turn the plate right side up and place in an oven for 20 min at 48 °C to dry.

5. Do one of the following:

Proceed directly to Stage 3 — Resuspension and Hybridization Preparation on page 62, even if 
some droplets of liquid remain. Leave the sample plate at room temperature.

Tightly seal the plate and store at –20 °C.

CAUTION: During this step, handle the plate gently to avoid disturbing the pellets. Do not
bump or bang the plate.

WARNING: We strongly recommend that you use the Eppendorf 5810R at 3200 xg 
(4000 rpm/) with:

Rotor A-4-81

Plate carrier DL 050 (rubber bottom)

If not using the Eppendorf 5810R with recommended rotor and plate carrier, centrifuge
the samples at 3200 xg (or rcf) at 4 °C.

Do not use the 5810R with the A-4-62 rotor and WO-15 plate carrier (hard bottom). Use of
this rotor and plate carrier may result in cracked plates, loss of sample, unbalanced
centrifugation, damage to the instrument and possible physical injury.

NOTE: If using a GeneChip® Hybridization Oven, place the plate on the bottom of the
oven. Plates do not rotate.
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Stage 3 — Resuspension and Hybridization Preparation

Duration
Resuspension and Hybridization Preparation

Equipment, Consumables, Labware and Reagents Required

Equipment and Labware Required

Table 3.12  Time required for resuspension

Hands-on time 15 min

Frozen pellet equilibration to room temperature 1.5 hr

Biomek FXP Target Prep Express 40 min

Total time 55 min to 2.6 hr

Table 3.13  Equipment, consumables and labware required

Quantity Item

As required Adhesive seals for plates

1 Bench top cooler, chilled to –20 °C

1 Ice bucket, filled with ice

1 Marker, fine point, permanent

1 Mini microcentrifuge (microfuge with microtube rotor)

1 Plate centrifuge, 4 °C

As required Adhesive seals for plates

1 Vortex

Biomek FXP Target Prep Express Labware

1 box of each Barrier pipette tips:
Biomek Span P50 (pink)
Biomek AP96, P250 (aqua)
Biomek Span P250 (green)
Biomek Span P1000 (yellow)

5 plates for 
on-deck 
cycling

OR:

BIO-RAD hard shell PCR 96-well 

For on-deck thermal cycling or when using the PTC-0240/PTC-200 off-deck thermal cycler

6 plates for 
off-deck 
cycling

4   BIO-RAD ( HSP-9631 ) Hard-Shell PCR 96-well Plate  and 
1   HSS-9601 Hard-Shell Full-Height 96-Well Semi- Skirted PCR Plate
1  Plate, Costar Brand Serocluster round bottom plate 

For off-deck thermal cycling using the ABI 9700 or ABI 2720 thermal cycler
Note: The HSS-9601 plate stacked on the Costar brand serocluster round-bottom plate should 
only be used on position P2 on the Biomek FXp deck. See Figure 3.35 on page 75.

1 Plate, OD
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Reagents Required

1. Preparing Frozen Pellets and Axiom Resusp Buffer

Allow the pellets and the Axiom Resusp Buffer to equilibrate to room temperature for 1.5 hr prior to 
starting this step.

2. Perform the Pre-Run Checklist
The following actions are the same as described under 1. Perform the Pre-Run Checklist on page 42. 
Refer back to this step for details. Some or all of these steps may not be required depending upon the 
current state of the Biomek workstation.

To perform the pre-run checklist:

1. Power on the Biomek FXP Target Prep Express and all peripherals.

2. Check the water and waste containers; replenish or empty as required.

3. Launch the Biomek Software.

4. If applicable, close the thermal cycler lid (on page 42).

5. Home all axes (on page 44).

1 Reagent block, chilled to 4 °C

1 Reservoir, 19 mL (quarter module, divided)

3 Reservoir, 40 mL (quarter module)

Table 3.14  Reagents required for resuspension and hybridization

Reagent Module

From the Axiom Reagent Kit

Axiom Hyb Buffer Module 2
Box 1, –20 °C

Axiom Hyb Soln 1

Axiom Resusp Buffer Module 2
Box 2, 2–8 °C

Axiom Hyb Soln 2

Other Reagents Required

Nuclease-Free Water, ultrapure MB grade
(USB, P/N 71786; for OD and gel plate preparation)

To fill line of divided reservoir

TrackIt Gel Loading Buffer, diluted

(see Appendix A, Fragmentation Quality Control Gel Protocol on 
page 223 for dilution instructions.)

96-array plate: 8 mL 

IMPORTANT: The pellets and the resuspension buffer must be at room temperature before
proceeding with this step.

Table 3.13  Equipment, consumables and labware required

Quantity Item
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3. Thaw and Prepare the Reagents

Thaw and Prepare the Reagents

To thaw and prepare the reagents:

1. Thaw Axiom Hyb Soln 1 on the bench top at room temperature.

2. Vortex the Axiom Resusp Buffer and the Axiom Hyb Buffer.

3. Vortex and spin Axiom Hyb Soln 1 and Axiom Hyb Soln 2.

4. Run the Resuspension and Hybridization Preparation Step

To run the Resuspension and Hybridization Preparation step:

1. Open Project > Open Project > Axiom Target Prep and click OK (Figure 3.30).

2. Click the Open Method icon, select Axiom Target Prep, and click OK.

3. Click the Run button.

4. Select your array plate format and Resuspension and Hybridization Preparation.

The deck layout for this method is displayed (Figure 3.31 on page 65).

NOTE: We strongly recommend that you run two quality process controls during this step:

A gel to verify successful fragmentation

An OD quantitation of each resuspended sample

The Biomek FXP Target Prep Express can be set to prepare fragmentation and OD plates that
are ready for processing. These process controls must be selected as a run preference prior to
starting a run. See Set the Biomek Software Default Settings on page 17 for instructions.

Figure 3.30  Selecting the Resuspension and 
Hybridization Preparation method
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5. Prepare the deck as shown in Figure 3.31, Table 3.15 and Figure 3.32 on page 67.

Label the BIO-RAD plates placed on the deck in positions P2 and P11. For example:

P2 — Hyb Ready + <sample description>

P11 — Gel QC

NOTE: Verify the appropriate plastic consumables are being used on the deck for the Hyb
Reaction Plate when using the ABI 9700 or ABI 2720 thermal cycle.

Figure 3.31  Deck layout for the Resuspension and Hybridization Preparation method

Table 3.15  Labware and reagent locations on the deck for Resuspension and Hybridization Preparation

Position 
on Deck

Labware Reagent or Samples

TL1 Biomek AP96 – P250 Pipette Tips (aqua) —

P1 ABgene 96 Square Well Storage plate Pelleted samples

P2 BIO-RAD Hard Shell 96-well plate

(Hyb Reaction Plate).
Bio-Rad Hard Shell 96-well plate (HSP 9631) for 
on-deck or off-deck thermal cycling using the 
TRobot 96, PTC-200 or PTC 0240. 
Bio-Rad Hard-Shell Full-Height 96-Well Semi-
Skirted PCR Plate (HSS 9601) stacked on a 
Costar Round Bottom plate for off-deck 
thermal cycling with the ABI 9700 or 2720 
thermal cycler

If Prepare plates for gel QC and OD 
after resuspension is selected in your 
run preferences, the following 
labware is required on the deck:

Multichannel P50 pipette tips
Dilution QC plate
Gel QC plate
OD QC plate (do NOT touch 
bottom of plate)

If not selected, these plates will not 
appear in the deck layout.
See Set the Biomek Software 
Default Settings on page 17 for 
more information.
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Warning: When using the ABI 9700 or the ABI 2720 off-deck thermal cycler for denaturing the hyb-ready 
plate, the Bio-Rad HSS 9601 Hard-Shell Full-Height 96-Well Semi-Skirted PCR Plate must be stacked on a 
CoStar Brand Serocluster Round Bottom plate (29442-392 from VWR International or EK-680568 from E&K 
Scientific) as shown in Table 3.2 on page 22.

The HSS9601 and HSP9631 PCR plates are not interchangeable on the Biomek FXp deck.

P3 Biomek Span P50 Pipette Tip (pink) —

P7 BIO-RAD Hard Shell 96-well plate —

P8 BIO-RAD Hard Shell 96-well plate 

P9 BIO-RAD Hard Shell 96-well plate

P10 Reservoirs in frame:
Quarter module (1)
Quarter module (2)
Quarter module (3)
Quarter module, divided (4 and 5)

Pour Axiom Resus Buffer into reservoir 1
Pour Axiom Hyb Buffer into reservoir 2
Leave reservoir 3 empty
Pour diluted gel loading buffer into reservoir 4:
– 8 mL for 96 samples
Pour nuclease-free water into reservoir 5 to fill 
line

P11 BIO-RAD Hard Shell 96-well plate (for Gel QC) —

P12 OD plate, 96-well UV —

Pelt_1 Reagent block, chilled to 4 °C See Figure 3.32 on page 67.

P13 Biomek Span P1000 Pipette Tips (yellow) —

P14 Biomek Span P250 Pipette Tips (green) —

Table 3.15  Labware and reagent locations on the deck for Resuspension and Hybridization Preparation (Continued)

Position 
on Deck

Labware Reagent or Samples

1 2 3

Empty
Buffer

Hyb
Buffer Reservoir

4

5
Water

Gel Load
Buffer

Resusp
Axiom Axiom
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6. Check the deck layout to ensure that the labware, reagents and samples are in the proper locations.

7. Click OK to continue the method.

The system will automatically flush the Span-8 fluidics system. Observe the lines and syringes for air 
bubbles.

8. At the prompt to repeat the Span-8 fluidics system flush:

Click No if no air bubbles are present.

Click Yes if air bubbles are present. Repeat the flush until no air bubbles are present.

9. Run the fragmentation gel and OD quantitation process controls.

For instructions and guidelines on assessing gel and OD results, see:

Appendix A, Fragmentation Quality Control Gel Protocol on page 223

Figure 3.32  Placement of reagents on chilled reagent block for GeneTitan reagent tray preparation

NOTE: If the physical deck does not match the Deck Layout window exactly (Figure 3.31
on page 65), either modify the physical deck to match exactly or choose Abort in the Deck
Layout window.

IMPORTANT: 
Position all plates and the chilled reagent block with A1 in the upper left corner of the frame.
Press reagent tubes into the block to ensure that they are fully seated.

A1

Axiom 
Hyb 

Soln 2

Axiom 
Hyb 

Soln 1
A1

Reagent block with template.
Only the positions used for this

method are shown.

Diagram of reagent block
without template
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Appendix B, Sample Quantitation after Resuspension on page 225

10. Do one of the following:

If the GeneTitan MC Instrument is free, and if the gel and OD quantitation results are good, you 
can proceed directly to Stage 4 — Preparation for the GeneTitan MC Instrument on page 72.

If the GeneTitan MC Instrument is not free, then follow the instructions shown in Figure 3.33. 
Tightly seal the Hyb Rxn plate and store at –20 °C.

Figure 3.33  Instructions to follow if the GeneTitan MC Instrument is not free
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Summary of Resuspension and Hybridization Preparation

Span-8 Pod ActivitiesMC Pod Activities

Continued on next page.
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Span-8 Pod ActivitiesMC Pod Activities

Continued on next page.


























































